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Answer: 
1.	 F		  2. T		  3. T

 

1.	 a. (i)	
	 b. �(The option of this question is printed incorrectly in the book, please correct it in your 

textbook.) 
		  Question: Which of these is the default location for saving any file? 
		  (i) Music (ii) Documents (iii) Both (i) and (ii)
		  Ans. (ii) 
	 c. (ii)
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which tool is used to delete temporary Internet files from the hard disk? 
		  Ans. (ii)
2.	 a. file explorer 	 b. right	 c. download	 d. control panel
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the use of Clock and Region setting?
		  Ans. It is used to change the date, time and language settings of your computer. It is also 

used to change the region where the computer is being used. 
	 b. Navigation pane is used to quickly jump between libraries and folders.
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	 c. Disk Cleanup tool is used to delete the files and clean the hard disk of the computer without 
affecting its functions.

	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Write the steps to change the colour settings of the taskbar in Windows 11. 
		  Ans. To change the colour settings, follow the given steps: 
		  Step 1: Right-click on the Desktop and choose Personalize option. 
		  Step 2: Scroll down to open Colors settings from Personalization group. 
		  Step 3: Scroll down and choose the desired colour. 
4.	 (This question was printed incorrectly in your book. Please change it in your textbook)
	� Tina is bored of using the default S	 tart menu and desktop background. She wants to 

change these settings to something new. Which Control Panel setting does she need to change 
the default Start menu and desktop background?

Ans:	Appearance and Personalization
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Answer: Line spacing 

 

1.	 a. (iii) 		 b. (iii)

2.
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	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which option is used to highlight the items in a list? 
		  Ans. (ii)
	 d. (iii)		 e. (iii)
2.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: ____________ refers to the design or appearance of characters.
		  Ans. Font
	 b. alignment
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Columns option is present under ____________ tab. 
		  Ans. layout
	 d. replace
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: In Word 2021, default font size is 11. 
		  Ans. T
	 b. F
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Ctrl + E is the shortcut key used for Center alignment. 
		  Ans. T
	 d. F
4. 	 a. Find option is used to find a specific word in a document.
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How many types of alignment options are available in Word 2021? 
		  Ans. There are four alignment options available in Word 2021. 
		  Align Left, Center, Align Right, Justify
	 c. To increase or decrease line spacing, follow these steps;
	    Step 1: Select the text or paragraph.
	    Step 2: Click on the Line and Paragraph Spacing option in the Paragraph group.
	    Step 3: Select the desired spacing option
	 d.	To highlight text, follow these steps:
	    Step 1: Select the text you want to highlight.
	    Step 2: Click on the Text Highlight Color tool in the Font group
	    Step 3: Choose the desired colour.
5.	 Left Align 	 Center Align
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Answer: 1. F	 2. T	 3. T

 

1.	 a. (ii)		  b. (i)	 c. (ii)	 d. (iii)
2.	 a. Insert	 b. template	 c. WordArt	 d. Format background	
	 e. Gradient
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Under which tab is the Pictures option present? 
		  Ans. Insert tab
	 b. Rotate handle 	 c. Illustrations 	 d. Format Tab 
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Click on which tab, to use templates? 
		  Ans. File tab
4.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Write the three ways in which a picture can be inserted in PowerPoint 2021. 
		  Ans. Three ways of inserting pictures are: This Device, Stock Images and Online pictures.
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can you apply the textured fill to all the slides? 

3.
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Answer: 1. F	 2. T	 3. T

 

1.	 a. (ii)		  b. (i)	 c. (ii)	 d. (iii)
2.	 a. Insert	 b. template	 c. WordArt	 d. Format background	
	 e. Gradient
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Under which tab is the Pictures option present? 
		  Ans. Insert tab
	 b. Rotate handle 	 c. Illustrations 	 d. Format Tab 
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Click on which tab, to use templates? 
		  Ans. File tab
4.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Write the three ways in which a picture can be inserted in PowerPoint 2021. 
		  Ans. Three ways of inserting pictures are: This Device, Stock Images and Online pictures.
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can you apply the textured fill to all the slides? 

3.

		  Ans. To apply texture fill, follow the steps given below: 
		  Step 1: Select a slide. 
		  Step 2: Click on Design tab. 
		  Step 3: Click on the Format Background option. 
		  Step 4: Select the Picture or texture fill option. 
		  Step 5: Select the texture you want to apply to your slide as a background from the Texture 

option. 
	 c. To insert an online picture in PowerPoint, follow these steps:
	    Step 1: Click on the Insert tab.
	    Step 2: Click on Online Pictures command.
	    Step 3: Select the desired picture.
	    Step 4: Click on the Insert button.
	 d. To use online templates, in PowerPoint, follow these steps: 
	    Step 1: Click on the File tab.
	    Step 2: Click on New option.
	    Step 3: Select the template you like.
	    Step 4: Click on Create button.
`	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can we insert WordArt into presentations? 
		  Ans. To insert WordArt to the existing text, follow the given steps: 
		  Step 1: Select the text. 
		  Step 2: Click on the Format tab. 
		  Step 3: Click on the Quick Styles command in the WordArt Styles group. 
		  Step 4: Select the desired WordArt style. 
5.	 a. Shapes 	 b. Quick Styles
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Periodic Assessment–1
(Based on chapters 1 to 3)

1.	 a. Downloads	 b. Documents	 c. Music	 d. Pictures	 e. Videos
2.	 a. F		  b. T	 c. T	 d. T
3.	 a. Ctrl + F	 b. Ctrl + H	 c. Ctrl + J	 d. Ctrl + R
4.	 Format Background

	Animation and Transition in PowerPoint

uiz Bee
Page-43

Answer: Motion Path

 

1.	 a. (i)		  b. (iii)	 c. (iii)
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which animation effect makes an object move in a specific pattern on the slide? 
		  (i) Emphasis	 (ii) Motion Path	 (iii) Entrance 
		  Ans. (ii)
	 e. (ii)
2.	 a. F		  b. T	 c. F	 d. F
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: PowerPoint has three categories of transition effects. 
		  Ans. T
3.	 a. Advanced Animation 	 b. Exit	 c. Animation Pane
	 d. Insert Tab
4.	 a. Animation is a visual effect that gives us the ability to move objects like text, pictures, charts, 

etc. in any direction in the slideshow.
	 b. A SmartArt graphic lets us present data or information in the form of flowcharts, and diagrams. 

These graphics are an impressive way to convey information easily and effectively.

4.
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Periodic Assessment–1
(Based on chapters 1 to 3)

1.	 a. Downloads	 b. Documents	 c. Music	 d. Pictures	 e. Videos
2.	 a. F		  b. T	 c. T	 d. T
3.	 a. Ctrl + F	 b. Ctrl + H	 c. Ctrl + J	 d. Ctrl + R
4.	 Format Background

	Animation and Transition in PowerPoint

uiz Bee
Page-43

Answer: Motion Path

 

1.	 a. (i)		  b. (iii)	 c. (iii)
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which animation effect makes an object move in a specific pattern on the slide? 
		  (i) Emphasis	 (ii) Motion Path	 (iii) Entrance 
		  Ans. (ii)
	 e. (ii)
2.	 a. F		  b. T	 c. F	 d. F
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: PowerPoint has three categories of transition effects. 
		  Ans. T
3.	 a. Advanced Animation 	 b. Exit	 c. Animation Pane
	 d. Insert Tab
4.	 a. Animation is a visual effect that gives us the ability to move objects like text, pictures, charts, 

etc. in any direction in the slideshow.
	 b. A SmartArt graphic lets us present data or information in the form of flowcharts, and diagrams. 

These graphics are an impressive way to convey information easily and effectively.

4.

	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can we access Animation Pane in PowerPoint? 
		  Ans. To access Animation Pane, follow the given steps: 
		  Step 1: Click on the Animation tab.
		  Step 2: Click on Animation Pane option.
	 d. To insert an audio file, follow the given steps:
	    Step 1: Click on the Insert tab. 
	    Step 2: Click on the Audio option in the Media group.
	    Step 3: Select the Audio on My PC option.
	    Step 4: Navigate the folder to find audio file.
	    Step 5: Select the audio file.
	    Step 6: Click on the Insert button.
	 e. To add transition effects to slides, follow the given steps:
	    Step 1: Click on the Transitions tab.
	    Step 2: Select the slide on which a transition effect is to be applied.
	    Step 3: Click on the More drop-down arrow in the Transition to This Slide group.
	    Step 4: Click the desired transition effect for your slide.
5.	 Entrance animation effect Emphasis animation effect

It adds effect to an object while it appears on 
the screen.

It emphasises on an abject in various ways, 
without it appearing or leaving the screen. 

6.	 a. Yes, the slide is using a theme.
	 b. WordArt
	 c. Yes, this presentation is using SmartArt from List category.
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	Excel 2021 — An Introduction

uiz Bee
Page-54

Answer: The cell that is highlighted in a spreadsheet is known as the active cell.

 

1.	 a. (ii)		  b. (iii)	 c. (i)	 d. (ii)	 e. (i)
2.	 a. Spreadsheet
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: A ribbon displays different _______________. 
		  Ans. Tabs
	 c. Formula bar	 d. Status bar
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which button should be clicked to exit Excel 2021? 
		  Ans. Close button 
	 b. Active cell	 c. Ctrl+A	 d. .xls	
	 e. Formula bar
4.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Write the name of any three commands appeared in the Backstage view. 
		  Ans. Three commands of Backstage view are: Save, Open, Print.
	 b. Components of excel window are as follows: Formula bar, Name bar, Active cell, and Ribbon. 
	 c. Uses of excel are:
	 • Storing and Analysing data: You can store data into numerous individual worksheets and 

analyze it accordingly.
 	 • Sharing Data: Excel 2021 allows users to share data with other users. You can import data 

from other resources like Microsoft Word and export data into other file formats.
	 d. To rename a worksheet, double click on the worksheet tab and type the name you desire. 
	 e. To create a new workbook in excel, follow these steps: 
	    Step 1: Click on the File tab.
	    Step 2: Click on Blank workbook.
	    Step 3: Click and start typing.

5.
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	Excel 2021 — An Introduction

uiz Bee
Page-54

Answer: The cell that is highlighted in a spreadsheet is known as the active cell.

 

1.	 a. (ii)		  b. (iii)	 c. (i)	 d. (ii)	 e. (i)
2.	 a. Spreadsheet
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: A ribbon displays different _______________. 
		  Ans. Tabs
	 c. Formula bar	 d. Status bar
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which button should be clicked to exit Excel 2021? 
		  Ans. Close button 
	 b. Active cell	 c. Ctrl+A	 d. .xls	
	 e. Formula bar
4.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Write the name of any three commands appeared in the Backstage view. 
		  Ans. Three commands of Backstage view are: Save, Open, Print.
	 b. Components of excel window are as follows: Formula bar, Name bar, Active cell, and Ribbon. 
	 c. Uses of excel are:
	 • Storing and Analysing data: You can store data into numerous individual worksheets and 

analyze it accordingly.
 	 • Sharing Data: Excel 2021 allows users to share data with other users. You can import data 

from other resources like Microsoft Word and export data into other file formats.
	 d. To rename a worksheet, double click on the worksheet tab and type the name you desire. 
	 e. To create a new workbook in excel, follow these steps: 
	    Step 1: Click on the File tab.
	    Step 2: Click on Blank workbook.
	    Step 3: Click and start typing.

5. 5.	 (This question was printed incorrectly in your book. Please change it in your textbook)
	� Amrit has completed his work in the Excel file by adding the relevant information about the 

ages of the 30 students in his class. Now he wants to add another worksheet in which he needs 
to enter data for other classes. Which sign can he use to insert a worksheet?

	 Ans: He can use the + sign to add a new worksheet.
6.	 (The question part d was printed incorrectly in your book. Please change it to L4.)

	

b.

a.
d.

e.

f.

c.

	 (i) A6		 (ii) Book 1	 (iii) 1	 (iv) Sheet 1
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Periodic Assessment–2
(Based on chapters 4 & 5)

1.	

File Tab

Quick Access toolbar Formula bar Title bar

Ribbon



PRO (Ver. 5.0)-V (Answer Key)10

� IMPRINT 2 

2.	 a. Standard	 b. Both	 c. Left hanging 	 d. Right hanging 
3.	 B4

Test Sheet–1
(Based on chapters 1 to 5)

1.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of the following displays the location of the hard drive in File Explorer? 
		  (i) Address bar		  (ii) Navigation pane	 (iii) Ribbon 
		  Ans. (i)
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Where is the view tab located in File Explorer? 
	 	 (i) Navigation pane	 (ii) Ribbon	 (iii) Address bar 
		  Ans. (ii)
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which option equally distributes the text between both the margins? 
	 	 (i) Centre		  (ii) Align Right	 (iii) Justify 
		  Ans. (iii)
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: A quick way to make a presentation in PowerPoint is by using ____________. 
	 	 (i) Samples		  (ii) Templates	 (iii) Themes 
		  Ans. (iii)
	 e. (ii)
	 f. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of the following displays the address of an active cell? 
	 	 (i) Name Box		  (ii) Quick Access Toolbar	 (iii) Ribbon 
		  Ans. (i)
	 g. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How many worksheets does a workbook contain, by default? 
	 	 (i) 1		  (ii) 2	 (iii) 3 
		  Ans. (i)
2.	 a. File Explorer
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: ____________ refers to the design or appearance of characters. 
		  Ans. Font
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	 c. Insert 
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: A ribbon displays different ____________. 
		  Ans. tabs
	 e. Format Background
3.	 a. T		  b. F
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Highlighting the text means removing the text. 
		  Ans. F
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Column formatting is the arrangement of the text in form of rows. 
		  Ans. F
	 e. (F)
4.	 (The option of this question is printed incorrectly in the book, please correct it in your textbook.) 
	 Question: Match the following: 
	 a. Shapes command 	 (i) Design tab 
	 b. Quick Styles command 	 (ii) Media group 
	 c. Texture Fill 	 	 (iii) WordArt Styles group 
	 d. Audio option 	 	 (iv) Replace 
	 e. Ctrl+H 	 	 (v) Illustration group
	 Ans. a. (v)	 b. (iii)	 c. (i)	 d. (ii)	 e. (iv)
5. 	 a. Control Panel
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What should we use to rotate a picture in the desired direction in PowerPoint? 
		  Ans. Rotation handle is used to rotate the picture in the desired direction. 
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the selected cell known as? 
		  Ans. A selected cell is known as the active cell. 
	 d. Animation
6.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the Navigation pane used for? 
		  Ans. It is used to quickly jump between libraries and folders. 
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can we rename a worksheet in Excel? 
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		  Ans. To rename a worksheet, the steps are as follows:
		  Step 1: Right-click on the worksheet tab you want to rename.  
		  Step 2: Select the Rename option. 
		  Step 3: Type the new name of your worksheet and press the Enter key. 
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How will you increase or decrease the blank space between the lines of a paragraph 

in Word? 
		  Ans. Line spacing can be increased or decreased by following the given steps: 
		  Step 1: Select the text or paragraph. 
		  Step 2: Click on the Line and Paragraph Spacing option in the Paragraph group. 
		  Step 3: Select the desired spacing option. 
	 d. To add transition effects to slides, follow the given steps: 
	    Step 1: Click on the Transitions tab. 
	    Step 2: Select the slide on which a transition effect is to be applied.
	    Step 3: Click on the More drop-down arrow in the Transition to This Slide group.
	    Step 4: Click the desired transition effect for your slide.

	Editing in Excel 2021

uiz Bee
Page-70

Answer: a. Undo	 b. Redo 
Page-71
Answer: a. Cut		  b. Copy

 

1. 	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of these is the shortcut key to redo? 
		  (i) Ctrl + Y	 (ii) Ctrl + C	 (iii) Ctrl + V 
		  Ans. (i)

6.



13PRO (Ver. 5.0)-V (Answer Key)

 IMPRINT 2

		  Ans. To rename a worksheet, the steps are as follows:
		  Step 1: Right-click on the worksheet tab you want to rename.  
		  Step 2: Select the Rename option. 
		  Step 3: Type the new name of your worksheet and press the Enter key. 
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How will you increase or decrease the blank space between the lines of a paragraph 

in Word? 
		  Ans. Line spacing can be increased or decreased by following the given steps: 
		  Step 1: Select the text or paragraph. 
		  Step 2: Click on the Line and Paragraph Spacing option in the Paragraph group. 
		  Step 3: Select the desired spacing option. 
	 d. To add transition effects to slides, follow the given steps: 
	    Step 1: Click on the Transitions tab. 
	    Step 2: Select the slide on which a transition effect is to be applied.
	    Step 3: Click on the More drop-down arrow in the Transition to This Slide group.
	    Step 4: Click the desired transition effect for your slide.

	Editing in Excel 2021

uiz Bee
Page-70

Answer: a. Undo	 b. Redo 
Page-71
Answer: a. Cut		  b. Copy

 

1. 	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of these is the shortcut key to redo? 
		  (i) Ctrl + Y	 (ii) Ctrl + C	 (iii) Ctrl + V 
		  Ans. (i)

6.

	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: To select the whole worksheet, click on _______________. 
		  (i) Redo command	 (ii) Select All Triangle	 (iii) Delete button
		  Ans. (ii) 
	 c. (iii)	d. (ii)
2.	 a. Header 	 b. Delete
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Cut option is present under _______________ group. 
		  Ans. Clipboard
	 d. Undo
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Modifying the text means correcting the content of the text without completely 

replacing the text. 
		  Ans. T
	 b. F		  c. T	 d. F	 e. T
4. 	 a. Moving the data means to move the data from the original location to a new location.
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can we select a range of cells using mouse? 
		  Ans. To select a range of cells using mouse. Left-click the mouse on one cell and drag it to 

the last cell. 
	 c. To insert a column in a worksheet, right click on the column and click on the Insert option. 
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How can you fill a number series in Excel using AutoFill feature?
		  Ans. For filling data in a sequence from 1 to 5, follow the given steps: 
		  Step 1: Select the cell and the numbers 1 and 2 in the first two cells (A2 and A3).
		  Step 2: Select both the cells and drag the Fill Handle down to cover the number of cells to 

be filled.
		  Step 3: Release the mouse button.   
	 e. To change the column width, follow these steps: 
	    Step 1: Select the column and click on the Format option in the Cells group.
	    Step 2: Select the Column Width option.
	    Step 3: Specify the new Column Width value.
	    Step 4: Click on OK button.
5.	 Specify the new Row Height.
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Answer: 
1. d.			  2. b.

	Computer Malware

uiz Bee
Page-83

Answer: Worms

 

1.	 a. (iii)		 b. (ii)	 c. (i)	        d. (iii)
2.	 a. Virus 	 b. Kaspersky	 c. Norton Antivirus
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question:  Write the name of the software that is harmful to the computer.
		  Ans. malicious software
3.	 a. We should update our antivirus regularly to keep it up to date with the latest information on 

viruses and malware.
	 b.	To avoid virus infection in our computers we can follow these steps:
		  • Install an antivirus program and ensure that it is updated timely.
		  • �Never allow any CD, DVD or pen drive brought from an untrusted source to be used directly 

on the computer without scanning for viruses. 
	 c.	An antivirus program scans all the files and when an infected file is identified, it tries to remove 

the malware. In case it fails to remove the infection, it quarantines the infected file. 
	 d.	They are received as an e-mail attachment from someone we know and appear legitimate.  

Once you click the attachment, download and install, the malware also gets installed into the 
computer.

	 e.	�• Install an antivirus program and ensure that it is updated on a timely basis.
		  • �Never allow any CD, DVD, or pen drive brought from an untrusted source to be used directly 

on the computer without scanning for viruses.
		  • Never open e-mail attachments from strangers.

7.
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		  • �Make sure the software on your computer is updated, including the operating system and 
browsers.

		  • Use the original operating system.
		  • Do not download music, programs, or games from unknown sources on the Internet.
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  Internet and E-mail

uiz Bee
Page-96

Answer: @

1.	 a.	(i)		  b. (i)
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of the following is used to type the e-mail address of the people we want 

to send a copy of the e-mail to? 
		  Ans. (i)
	 d. (ii)
2.	 a.	E-mail	 b. Domain	 c. Subject	 d. Sign out
3.	 a.	(This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What separates the username and domain name in an e-mail address?
		  Ans. @ (pronounced as ‘at’). 

8.
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	 b. G-mail	 c. Blind carbon copy		 d. Attachment
4. 	 a.	E-mail stands for electronic mail. It is used to send messages to multiple people, sitting at 

different geographical locations, within a few seconds.
	 b.	(This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the use of Compose option? 
		  Ans. This feature allows us to create an e-mail before sending it. 
	 c.	To create an e-mail account, follow these steps:
		  Step 1: Type 'www.gmail.com' in address bar of the browser.
		  Step 2: Select the Create account option
	  	 Step 3: �Fill in the required details and click on Next button.  
		  Step 4: Fill your details and click on Next button. 
		  Step 5: �Google will ask your permission to send you a verification code to verify your phone 

number. Click on Send button. 
		  Step 6: Enter the verification code.
		  Step 7: �Click on the Verify button. Step 8: If you like, you can add your phone number to 

your account for use across Google services. To add click on the Yes, I m in option 
else click on Skip to skip the step.  

		  Step 9: Read the terms and conditions. 
		  Step 10: Click on I agree button. 
	 d. To sign out from an email account, follow these steps: 
	    Step 1: Click on the icon containing first letter of your name.
	    Step 2: Select the Sign out option.
	 e. To attach a file to an e-mail, follow these steps: 
	    Step 1: Click on the Attach files option.
	    Step 2: Browse and select the file you want to attach.
	    Step 3: Click on Open button. 
5.	 a. To attach a file to an e-mail, follow these steps: 
	    Step 1: Click on the Attach files option.  
	    Step 2: Browse and select the file you want to attach. 
	    Step 3: Click on Open button. 
	 b.	Bcc
	 c. 	i. Discussion about the project
		  ii. No
		  iii. �It means that the others who receive the email will not know that the person in bcc has 

also received the e-mail.
		  iv. �To: This field contains the name of the recipient. Send: This button is used to send the email.
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Answer: 
a. SOLD		  b. $%(!&	 c. replace ! with (

Periodic Assessment–3
(Based on chapters 6 to 8)

1.	 a. Ctrl + a	 b. Ctrl + Space	 c. Ctrl + -	 d. Ctrl + Y
2.	 1   Right-click on the cell and select Insert option.
	 3   Click on OK button.
	 2   Select the desired option.
3. 	 a. Cc
 	 (This question is printed incorrectly in the book, please correct it in your textbook)
	 b. �Ananya wanted to download some study material from the Internet. Which program should 

she install first in her computer to safeguard it from virus?
Ans.	Antivirus.
4.	 a. Antivirus	 b. Malware	 c. Antivirus	 d. Malware
	 e. Antivirus	 f. Antivirus	 g. Malware

	More on Scratch

uiz Bee
Page-104

Answer: ask and wait block

 
1. 	 a. (i)		  b. (iii)
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Under which blocks start sound Meow block is present? 
		  (i) Sensing	 (ii) Sound	 (iii) Motion 
		  Ans. (ii)

9.
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	 d. (ii)
2.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: The key...pressed? block is used to check whether a specified key is pressed. 
		  Ans. T
	 b. T	
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Green Flag button is used to see the output. 
		  Ans. T
	 d. F
3.	 a. Sprites
	 (This question is printed incorrectly in the book, please correct it in your textbook)
	 b. This block makes an input box at the bottom of the screen.
Ans.	Ask and wait
	 c.	Variables	 d. Sensing
4.	 a.	(This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the use of touching color block? 
		  Ans. It checks whether its sprite is touching a specified colour. If it is, the block returns ‘true’. 

It is used with an if-then block. 
	 b.	(This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: How to create touching edge block from touching mouse pointer block?
		  Ans. Click on the drop-down arrow present next to touching mouse pointer block and select 

edge from the list. 
	 c.	To create a variable for all the sprites, follow the given steps:
		  Step 1: Click on the Variables Block. 
		  Step 2: Click on Make a variable. 
		  Step 3: Type a name in New Variable name box. 
		  Step 4: Select whether the block is ‘For all sprites’ or ‘For this sprite only’. 
		  Step 5: Click on OK button. 
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the function of answer block? 
		  Ans. It holds the most recent text entered with the Ask () and Wait block. 
5.	 Local Variables Global Variable

It can only be accessed or modified from the 
sprite where it was created..

 It can be created on any sprite but its value 
can be accessed or modified by other sprites 
used in the project. 
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6.	 a. This block is used to ask a question to the user.
	 b. �This block is used to check whether the sprite is touching anything. This block is commonly 

used with the if block to perform a conditional check.
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Do yourself

     Creating Game in Scratch

uiz Bee
Page-109 

Answer: Paint new backdrop option is used to paint a new backdrop.

 

1.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: The when I receive New Message block is present under _____________ section. 
		  (i) Sensing	 (ii) Event	 (iii) Control 
		  Ans. (ii)
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: To draw a circle, click on _____________ button. 
		  (i) Sprite	 (ii) Convert to Bitmap	 (iii) Line 
		  Ans. (ii)
	 c. (ii)
2.	 a. F		  b. F	 c. F	 d. T

10.
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3.	
3

1

5

2

4

4. 	 a. Broadcast block is used to send messages among the sprites. 
	 b. Text tool is used to add text on stage.
	 c. To create a variable, follow these steps: 
	    Step 1: Click on the Data Block.
	    Step 2: Click on Make a variable.
	    Step 3: Type a name in New Variable name box.
	    Step 4: Select whether the block is ‘For all sprites’ or ‘For this sprite only’.
	    Step 5: Click on OK button. 
	 d. To add the text, follow the given steps: 
	    Step 1: Click on the Text tool to add the title of the game. 
	    Step 2: Click on the main painting area. 
	    Step 3: Type the title of the game. You can choose font colour and font as per your choice. 
		  To move and resize the text, follow the given steps: 
	    Step 1: �Click on the Select tool to move the text to the top-right corner of the screen by using 

the drag-and-drop method. 
	    Step 2: �Use the resizing handles to adjust the size. 
5.	 Paint option

COding Zone
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Do it yourself
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	Evolution of Artificial Intelligence

uiz Bee
Page-124

Answer: (any two) Siri and Cortana

 

1.	 a. (i)		  b. (iii)	 c. (i)	 d. (ii)
2.	 a. F		  b. T	 c. F	 d. F
3.	 a. Spirit and Opportunity 	 b. Kinect for XBox 360	 c. Sophia
	 d. Asimo
4. 	 a. 	Google Home is a smart speaker Google released in 2016. 
	 b. John McCarthy was the first person to coin the term Artificial Intelligence in the DartMouth 

Conference held in 1956. 
	 c. Artificial Intelligence or AI refers to software technologies that give machines or robots the 

intelligence to perform tasks generally performed by intelligent beings. 
	 d. The 1970s saw an expansion of the computer era with the development of much quicker 

and affordable machines, with higher storage capacity. Their characteristics include abstract 
thinking, self-recognition, and could accomplish natural language processing. 

		  The development of the intelligent robot WABOT (Waseda robot) possessing human-like 
characteristics began in Japan at Waseda University. 

	 e. Speech recognition, decision-making, language translation, and visual perception are some 
examples of human intelligence that artificial intelligence may possess. 

5. 	 a. Amazon Alexa	 2014
	 b. WABOT-2	 1980
	 c. ASIMO 	 2000
	 d. Google Home	 2016
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a.	 21    81	 b. 50, 25, 12.5

11.
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Periodic Assessment–4
(Based on chapters 9 to 11)

1.	 a. Touching	 b. Ask 	 c. Answer	 d. is pressed
2.	 a. WABOT-2	 b. Jabberwacky 	 c. KISMET	 d. Roomba
	 e. Amazon Alexa	 f. ASIMO
3.	 Paint option

Test Sheet–2
(Based on chapters 6 to 11)

1.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Under which tab is the Format option in the Cells group present? 
		  (i) Insert (ii) Design (iii) Home 
	 Ans. (iii)
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which of the following software is harmful to the computer? 
		  (i) System software	 (ii) Application software	 (iii) Malicious software
		  Ans. (iii)
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is the name of the component which receives all the e-mails? 
		  (i) Inbox	 (ii) Sent	 (iii) Drafts 
		  Ans. (i)
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: In which category is the Answer block present? 
		  (i) Variables	 (ii) Sensing	 (iii) Motion 
		  Ans. (ii)
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: To draw a circle, click on ______________ button. 
		  (i) Sprite	 (ii) Convert to Bitmap	 (iii) Line 
		  Ans. (ii)
	 f. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Who is known as the father of Artificial Intelligence? 
		  (i) John McCarthy	 (ii) Alan Turing	 (iii) Allen Newell 
		  Ans. (i)
	 g. (ii)
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2.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Cut option is present under ______________ group. 
		  Ans. Clipboard 
	 b. Signing out
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: To select a column, place the mouse pointer on the column ______________. 
		  Ans. header 
	 d. Ask and wait
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: We can only send and receive electronic mail from our _____________ account.
		  Ans. e-mail 
3.	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: The key...pressed? block is used to check whether a specified key is pressed. 
		  Ans. T
	 b. T
	 c. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Event block is used to broadcast any message. 
		  Ans. T
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Asimo was the first-ever robot to get citizenship in a country. 
		  Ans. F
	 e. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Gmail is one of the most popular email provider.
		  Ans. T 
4.	 (The option of this question is printed incorrectly in the book, please correct it in your textbook.) 
	 Question: Match the following: 
	 a. Siri 		  (i) Control section 
	 b. if...then block 		  (ii) Virus 
	 c. Ctrl+Y 	 	 (iii) Virtual Assistance 
	 d. Jerusalem 		  (iv) Domain name 
	 e. gmail.com 		  (v) Redo 
	 Ans. a. (iii)	 b. (i)	 c. (v)	 d. (ii)	 e. (i) 
5. 	 a. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: Which block category control the movement of a sprite in a better manner in 

Scratch? 
		  Ans. Sensing block. 
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 	 b. Carbon Copy 	 c. WABOT
	 d. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question:  Write the name of the software that is harmful to the computer.
		  Ans. malicious software
	 e. Autofill
6. 	 a. To insert a cell, follow the given steps:
		  Step 1: Right-click on the cell and select Insert option. 
		  Step 2: Select the desired option. 
		  Step 3: Click on Ok button.
	 b. (This question is printed incorrectly in the book, please correct it in your textbook.) 
		  Question: What is Google Home? 
		  Ans. Google released Google Home in 2016. It uses AI to act as a personal assistant helping 

the user by reminding tasks, creating appointments, and searching for information by voice. 
	 c. To create an e-mail account, follow these steps:
	    Step 1: �Type 'www.gmail.com' in address bar of the browser.
	    Step 2: �Select the Create account option
	    Step 3: �If you want to create an e-mail for personal use, click on For myself option or for 

business purposes, click on To manage my business option. 
	    Step 4: �Fill in the required details and click on Next button.
	    Step 5: �Fill your details and click on Next button. 
	    Step 6: ��Google will ask your permission to send you a verification code to verify your phone 

number. Click on Next button.
	    Step 7: �Enter the verification code.
	    Step 8: �Click on the Verify button.
	    Step 9: �Read the terms and conditions. 
	    Step 10: �Click on I agree button.
	 d. A worm is a self-propagating program that works without human intervention. It is a kind 

of malware that uses a computer network to send copies of itself to another computer on 
the same network. It does not require human action to activate it. But for the worm to be 
activated,  someone needs to insert it directly into a network of interconnected computers 
where information can be exchanged between them.


